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What do we use our computers to accom-
plish? How have they helped us think, explore, cre-
ate and grow? Is your computer usage less that it
used to be…or is it more? And isn't it amazing how
much computing power we can hold in the palms of
or hands these days,or carry around in our pockets?

With the pervasiveness of the social
networking sites increasing on a daily basis, we
seem to be sharing more and more information that
might have just as well remained private. And yet,
there is so much great information that we can
access and share these days, we'd like to show you a
great starting point for some new, personal
investigation.

Have you ever heard of TED? Do you know
what TED is about?

" It started out in 1984 as a conference
bringing together people from three worlds:
Technology, Entertainment, Design. Since then its
scope has become ever broader. Along with two
annual conferences -- the TED Conference and
TEDGlobal -- TED includes the award-winning
TED Talks video site, the Open Translation Project
and TED Conversations, the inspiring TED Fellows
and TEDx programs, and the annual TED Prize.
TED conferences bring together the world's most
fascinating thinkers and doers, who are challenged
to give the talk of their lives (in 18 minutes or less). "

The concept behind TED is that ideas
should be shared among all people, throughout the
world. The TED conference , held annually on the
West Coast, includes science, business, the arts,
technology, and the global issues facing our world.
TEDGlobal meets in new locations throughout the
world,with themes specific to the region.Each of
the 18 minute talks take place over a 4 day period
with 50 speakers interspersed with shorter
presentations including music, performances and
comedy. All attendees see all of the events. The
important thing is that the atmosphere is designed
to excite and stimulate thinking on many levels.

There is an amazing array of specialized
events that have grown up around the world based
on the enthusiasm created by the TED Conferences
and the resultant TED Talks. If the content of the
conferences was limited to those attending in
person, it would be sad, indeed. Luckily for the rest
of us, speakers and performers have been recorded
as TED Talks video events and have been made
available via the TED website. There are over 1500
titles to peruse free of charge with subjects on the
leading edge of creative thinking, research and
development. TED Talks will make up the program
for our next MACNJ meeting.

So come to this Saturday's meeting
(November 9th) and check out some amazing
ideas…We'll have a sampling of some of the newest
experimental uses of robots, see the flying power of
Quadcopters, a mechanical bird that Leonardo
DaVinci would have loved, watch with awe
Google's driverless car and visit with DavidPogue
and learn a few tricks for your mobile computer.

Coffee, bagels and doughnuts as usual. Bring
a friend!
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by Allan Hoffman, 10/25/13, the Star
Ledger (reprinted with permission)

You can’t read “The Circle,” Dave Eggers’s
novel about a powerful internet company,
and not recognize the book’s dystopian vi-
sion in our own obsessions with sharing
and social media.

The novel, set in the near future, is an en-
gaging mix of social satire and cautionary
tale. It tells the story of Mae, a young
woman whose life is up-ended after being
hired by the Circle, a company portrayed
as a mix of Facebook and Google. Already
a best-seller, the book is igniting discussions about a fu-
ture where privacy is eroded, surveillance is the norm,
and sharing your life online is a must.

The book may not be our era’s “1984,” but it certainly
captures the perils of the internet— and, in particular,
the over-the-top utopianism sometimes espoused by
technology executives— more than any other novel of
recent years. Even if you don’t plan to read it, you’ll
want to be able to talk about it. Here’s a guide to the is-
sues it tackles:

All information must be known.
As Eric Schmidt, Google’s executive chairman, once
said, “I don’t believe society understands what happens
when everything is available, knowable and recorded by
everyone all the time.” That’s where we’re headed, and
Eggers gives a sense of what we’re in for. Wearable
cameras capable of broadcasting your life? Health
bracelets to record your bodily rhythms and transmit
the details to databases in the cloud? These are already
here, if not in widespread use.

Sharing is mandatory.
Early in the novel, in a scene that’s both hilarious and
foreboding, Mae is castigated by representatives from
human resources for not “sharing” (that is, posting on-
line) the details of an afternoon kayak trip. After all, she

could have documented what she saw.
“It’s just maddening,” an HR rep says,
“thinking of how much knowledge is
lost every day through this kind of
shortsightedness.” Sharing is a compul-
sion among Circlers, as they’re called
— essentially a mandated condition of
their employment.

Privacy is an outdated
concept.
Or, as a Circle slogan has it, “Privacy is
theft.” Open information— trans-
parency— is viewed as a public good.
Privacy? It’s an act of selfishness— al-
most a crime.

Influence will be ranked.
The employees of the Circle engage in a frenzied com-
petition to climb up a company ranking of their partici-
pation in social media. Sign up for Klout (“grow your in-
fluence by sharing your passions and expertise”), and
you’ll see something like this in action now: “The Klout
Score is a 1-100 number showing how influential you
are. See how you compare online.”

Solitude is strange and anti-social.
The word “alone,” when it appears in the book, carries
an almost ominous weight. Being alone— without a
friend, without a device to connect to others— is
viewed as really, really weird.

Technology can solve every prob-
lem.
The wizards at the Circle have an implicit faith in tech-
nology. As Mae thinks at one point, “Homelessness
could be helped or fixed, she knew, once the gamifica-
tion of shelter allotment and public housing in general
was complete.” With more information, the thinking
goes, everything can be solved— disease eradicated,
child abduction ended, auto accidents reduced in num-
ber.

Future portrayed in new novel is eerily close to our present

( continues on page 3 )
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Cameras are everywhere in the world of “The Circle,”
either worn by people, to record every moment (and be
“clear” or “transparent”), or installed unobtrusively
around the globe. Sounds creepy, but guess what? If you
encounter someone wearing Google Glass, the compa-
ny’s wearable internet device, you might not realize
you’re being recorded.

Information lasts forever.
When you post something online (or record it, even in-
advertently), it stays there— no matter how lurid. Mae
learns this in an incident I would rather not share.
(Think Anthony Weiner.) As one of the Circle’s leaders

tells her, “You know we don’t delete.”

“The Circle” portrays an increasingly brainwashed pop-
ulation enthralled with online sharing and the life of the
screen. Is the world conjured in the novel a far-off
dystopia?* I’d like to think so, but when you see what
technology is up next— wearable, internet-connected
displays, such as Google Glass, and smartwatches with
the world’s information available at a glance— you’ve
got to wonder whether the novel’s near-future is very,
very close to our present.

*dystopia is the opposite of a utopia

Everything will be recorded.
( continued from page 2 )

Earlier this month, when 1Password 4 was released for Mac, I raved about the return of Wi-Fi Sync. There was just
one problem: AgileBits hadn’t yet updated the iOS version to enable the feature.

Thankfully, 1Password 4 for iOS [https://itunes.apple.com/us/app/1password-password-manager/id568903335?
mt=8&at=10l5PW] ($17.99) has now been updated to version 4.3 to support Wi-Fi Sync. Once you have the update,
follow these steps to enable the feature.

In the Mac version of 1Password, choose Window >Wi-Fi Sync (Command-9) to display a pairing code.

1Password 4 for iOS Updated to Support Wi-Fi Sync
by Josh Centers

( continues on page 4 )
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( continued from page 3 )

Then, in the iOS version of 1Password, tap Settings > Wi-Fi Sync, select your computer from the list, tap the

Secret field and enter the code.

After you’ve finished the setup, to sync your logins over Wi-Fi, make sure you have the iOS app open and
unlocked, and then choose Window >Wi-Fi Sync in the Mac app.

Unless otherwise noted, this article is copyright © 2013 TidBITS Publishing, Inc.. TidBITS is copyright © 2008 TidBITS
Publishing Inc. Reuse governed by this Creative Commons License: http://tidbits.com/terms/.

When Apple released iTunes 11.1, I was excited to see

that it offered expanded podcast capabilities, such as

iCloud syncing and the creation of smart podcast

playlists, which Apple calls “stations”. However, we’ve

heard from a number of readers who are confused about

how podcasts now work in iTunes, and after playing

around with it, I was confused myself. After a couple of

weeks of use, I think I’ve finally figured it out, apart

from what I certainly hope are bugs in iCloud syncing.

I’ll start by explaining the easy stuff— subscribing and

listening to podcasts, and managing stations— before

delving into the confusing aspects of managing and

syncing podcasts.

Subscribe to Podcasts -- There are two
ways to subscribe to a podcast in iTunes 11.1: inputting a

URL manually or finding it in the iTunes Store.

To subscribe to a podcast manually, copy its URL

(presumably from aWeb site that’s offering it), and in

iTunes, select File > Subscribe to Podcast. A window

opens with a URL field. Paste in the URL and click

OK.

Explaining Podcasts in iTunes 11.1
by Josh Centers

( continues on page 5 )
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To find a podcast and subscribe
via the iTunes Store, click the
iTunes Store link in the upper
right of the main iTunes window
or in the iTunes sidebar, if
showing, assuming you’re not
already in that screen. Click the
Podcasts action label toward the
top to see all available podcasts,
or click the arrow to the right of
the Podcasts action label for a
menu of podcast categories. Of
course, you can search for a
specific podcast via the search
box in the upper right, and many
podcast Web sites link directly
to their pages in the iTunes
Store.

Once you click a podcast to view its details, you can click the big Subscribe

button in the left-hand column to subscribe.

-- To listen to podcasts, first enter the Podcasts view in your iTunes Library. (If you’re not already in your
Library, click the Library button on the right side of the iTunes window, and then choose Podcasts from the pop-
up menu on the left or select it in the sidebar, if showing.) There are four ways to view podcasts, selectable by
action labels in the top-center of the window: Unplayed, My Podcasts, List, and My Stations, the last of which I’ll
discuss separately.

Listen to Podcasts

Unplayed shows unplayed individual episodes, sorted in order of release, with the newest episodes on top. To play
an episode, just double-click it.

( continues )
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If the episode you want isn’t showing, click the Old Episodes button to the right of the screen to reveal the entire
list of available episodes. To add an episode to your listening queue, click the circle to the right so that it’s filled by
a checkmark, or click the Add All button at the top. Click Done and the episode(s) will be in the list.

The most familiar way to view your podcasts is probably the List view, which presents your podcast subscriptions
and episodes in classic iTunes “spreadsheet” format. You can click column headers to sort podcasts by length,
release date, or any number of other options available by Control-clicking a column name and adding a new
column. Click the arrows toward the left of each podcast name to expand a subscription and view individual
episodes. When a subscription is collapsed, it’s described by the information from the latest episode

( continues )



Volume 28, Number 11 www.macnj.org page 7

MACNJ Serving the Central New Jersey Macintosh Community since 1986 November 2013

Once you’re listening to a podcast in iTunes, you can
use the media controls in iTunes or your keyboard’s
media keys to control podcasts, but not very well in the
context of podcasts. For instance, the Next Track
button skips to the next podcast episode in the list, and
the Previous Track button skips to the previous podcast
episode in the list. And if you’re already on the first
podcast in a list, it jumps back to the beginning of the
episode. That is all rational, but wrong.

Why? Most podcast listeners are going to spend more
time skipping around in an episode than between
episodes. The reasoning is obvious. Most songs last less
than five minutes. Skip between songs and lose your
place? Not a big deal. But many podcasts last an hour or
more, making playback position inside a single audio
track much more important than which track is playing.
If I accidentally lose my place in a lengthy podcast by
clicking a media control button in iTunes, I’m going to
be angry.

I almost never want to skip to the start of a podcast,
and if I do, I can use the scrubber. The most common
controls I want in a podcast player— which Instacast
and Downcast both offer— are those that let me skip
forward or back by a few seconds, either to skip the
same ad I’ve heard hundreds of times or to catch
something I missed.

Fortunately, if you use the Keyboard Maestro [http://
www.keyboardmaestro.com/] macro utility from
Stairways Software, I have a solution for you. With help
from Justin Blanton, I’ve created a pair of macros
[http://tidbits.com/resources/2013-10/iTunes-30-sec-
KBM-macros.zip] to skip forward or back 30 seconds in
iTunes. Once you’ve downloaded them and installed by
double-clicking the .kmmacros file in the Finder, you
can invoke Skip Forward by pressing F7 and Skip Back
with F9. If you’re using an Apple keyboard, that may
require holding down Fn and pressing the previous (F7)
or next (F9) track keys to activate the macros.

Station to Station -- If you click the My
Stations action label, you can create and listen to
collections of podcasts of your choosing, which Apple
now calls “stations.” Why not just call them “playlists,”
like normal people would? Because station lists are
separate from music playlists in iTunes.

You can still add individual podcast episodes to
playlists, which could be useful for playing a series of
episodes on an older iPod, for instance. To do that,
under My Podcasts, choose an episode (it must have
been downloaded already), click the arrow to the right
of the podcast title, click Add To, and then choose the
desired playlist from the menu. However, if your playlist
is stored in iCloud through iTunes Match, adding a
podcast to the playlist will remove the entire playlist

( continues )
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from iCloud and make it available only on your computer.

In most situations, I don’t recommend using playlists for podcasts. Stations are designed specifically for podcasts,
and, in theory, sync to the Podcasts apps in iOS and on the Apple TV.

By default, iTunes gives you a station called Most Recent that features the most recent episode from each of your
subscriptions. But you’re not limited to that station. To get started with adding a new one, click the plus sign at
the bottom of the My Stations sidebar, and enter a name for the station.

Apple provides a number of helpful options for stations. You can include all subscribed podcasts or choose them
individually from the list. In the station settings, you can configure play order; how many episodes of each podcast
to include; and whether you want audio, video, or both. You can also choose to include only unplayed podcasts.
With these settings, you could easily set up a station that includes only the last two unplayed video podcasts from

( continues )
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the TWiT Network, for instance, or the most recent episode from each of four food-related podcasts you listen to.

Back in the My Stations view, double-click a station in the sidebar list to start playing its first episode, or double-
click an individual episode in the list to the right. As noted previously, the media keys cycle through episodes in the
station.

Manage Podcasts -- So far, so good. Where things start to get confusing is when you want to delete or
unsubscribe from a podcast. Part of the confusion stems from the fact that iTunes can now play either downloaded

podcast episodes or episodes stored in the cloud. If an episode isn’t stored locally, its description will be badged

with a cloud icon with an arrow in the center

Is it preferable to download episodes or stream them from the cloud? My take is that, unless your Mac is
frequently offline, it’s generally better to turn off downloads so you don’t have to waste disk space on them. To set
defaults for all podcasts, enter the List view, click the Settings button at the bottom left of the screen, and then set
Automatically Download to Off. In this dialog, you can also tell iTunes how often to check for new episodes and
how many episodes to keep.

To override the default settings for an individual podcast, go the to My Podcasts view, select a show in the sidebar,
and then click the Settings button in the upper right corner of the screen to reveal a pane that lets you tweak the
options and set the sort order. Click Done when you’re finished.

To remove an episode, subscription, or station, select it, click Delete, and confirm your action. If you’re deleting
something that’s associated with local files, iTunes asks if you want to delete them as well, but it does so only if

( continues )
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they’re in your iTunes Media folder. Now that iTunes
11.1 can stream podcasts from the cloud, there’s much
less reason to download at all, as I mentioned before,
and there’s little worry about deleting local files since
you can always get the episodes back from Old
Episodes.

Figure Out Sync -- In theory, iTunes 11.1
syncs your podcast subscriptions, stations, and
playback positions via iCloud among iTunes, the iOS
Podcasts [https://itunes.apple.com/us/app/podcasts/
id525463029?mt=8&at=10l5PW] app, and the Apple TV
Podcasts app. (Check your settings to make sure
syncing is enabled everywhere. In iTunes, look in the
Store pane of the Preferences window. In iOS, look in
Settings > Podcasts. On an Apple TV, make sure you’re
signed into the same iTunes account under Settings >
iTunes Store.)

What this means is that you should be able to
subscribe to a podcast and have it appear on your Mac,
iPhone, iPad, and Apple TV. Listen to part of an
episode on any one of the devices, and when you pause
and later use another device you should be able to pick
up exactly where you left off. That’s how it works, in
theory. In theory, the U.S. government is functional.

The reality is that syncing of this information through
iCloud is confused beyond belief, rife with incorrect
and inconsistent behavior. In extensive testing, we
experienced a variety of problems, at least some of the
time. Sometimes one problem went away, only to be
replaced by another.

• Podcast subscriptions disappearing and
reappearing randomly, and differently on four
devices

• Subscriptions syncing from one device to
another in only one direction

• Available episodes in a podcast differing
between devices

• Stations syncing without theirunderlying
subscriptions syncing as well

• Playback position syncing from iTunes to an
iPhone, but not an iPad

If you’d rather sync podcasts via USB between iTunes
and your iOS device, you can still do so, but it’s not
clear to me if it works any better (and of course won’t
work with the Apple TV). If you’re accustomed to
listening to podcasts in the iOS Music app, sorry.
Apple stripped all podcast functionality from the
Music app in iOS 7, so you must now use the Podcasts
app to access podcasts synced from iTunes. (If you use
Downcast [https://itunes.apple.com/us/app/downcast/
id393858566?mt=8&at=10l5PW] for iOS, which also
relies on iCloud for syncing, all of Apple’s apps will
pick up your Downcast subscriptions, but Downcast
won’t see changes from Apple’s apps.)

Just Use Instacast -- After trying to use
iTunes 11.1 to listen to podcasts for a few weeks, I’m
going back to Instacast for Mac and iOS, and I suggest
you do so as well. Even after completely overhauling
the way podcasts are handled, it’s obvious that Apple
just doesn’t get it. Syncing is broken, iTunes doesn’t
offer sensible controls for podcast listening, and the
Podcasts app’s iOS 6 aesthetic looks and feels horribly
dated.

What’s so frustrating is that it’s almost good. If Apple
fixed syncing so everything synced bidirectionally
among all apps, implemented better playback controls
in iTunes, and redesigned the Podcasts app for iOS 7,
then the company would have a decent solution for
most people. But after watching several attempts over
recent years, I’m convinced that Apple just doesn’t
have the interest in applying its usual attention to
detail to podcasts as it does to other things.

For full attention to podcast detail, turn to Vemedio
[http://vemedio.com/], developers of Instacast, which
has been updated, for free, for iOS 7. The Mac version
of Instacast is also excellent, and the sync between the
two is nearly perfect, other than a brief outage earlier
this month that was nicely and apologetically explained
by Vemedio. Together, both apps cost $25, but if you’re
a frequent listener who likes to switch between devices,
the investment is well worth it.
Unless otherwise noted, this article is copyright © 2013 TidBITS
Publishing, Inc.. TidBITS is copyright © 2008 TidBITS Publishing
Inc. Reuse governed by this Creative Commons License: http://
tidbits.com/terms/.
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Google caused a commotion when it announced updates to its Terms of Service to allow the search giant to begin
using user reviews in ads. (Users are alerted to the changes by a bar that appears at the top of at least some Google
sites.) “Shared endorsements,” as Google calls them, will place your name, photo, comments, and ratings in Web
ads seen by your friends. This can include businesses reviewed in Google Maps, reviews from the Google Play
store, and anything on the Web for which you’ve clicked a +1 button.

This isn’t quite as troubling as it first appears. After all, the entire point of reviewing products is to inform the
public. That said, I have two problems with Google’s approach.

First, if Google is going to monetize the work of its users, then it should share the profits. Companies pay
celebrities big bucks for endorsements— we common folk should be compensated as well. Such an approach
would encourage even more users to review products, although it might lead to an epidemic of sock puppetry.

Second, whether or not Google were to share revenues with users, the addition of user reviews to Web ads could
give Google an uncomfortable incentive to encourage positive reviews and possibly hide or sanitize negative ones.

The good news is that it’s easy to opt out of shared endorsements, and you may already have opted out in the
distant past by answering a similar question while signing up for Google+. Just visit the Shared Endorsements
settings page [https://plus.google.com/settings/endorsements?hl=en] and deselect the checkbox reading “Based
upon my activity, Google may show my name and profile photo in shared endorsements that appear in
ads.” (Parsing the meaning of the checkbox with such wording is on par with having to select the Limit Ad
Tracking option in Apple’s iOS privacy settings to opt out of ad tracking; fortunately, Apple moved that control
from iOS 6’s hidden Settings > General > About > Advertising location to the sensible Settings > Privacy >
Advertising spot in iOS 7.)

While we certainly don’t recommend allowing Google to use your work in shared endorsements, at least Google
lets you opt out. Facebook’s “sponsored stories” do very much the same thing, and Facebook doesn’t let you to
opt out, only control who can see your activity [https://www.facebook.com/help/222629841080902]. (Facebook
introduced sponsored stories in January 2011 without changing its terms of service and ended up paying $20
million to settle the resulting class-action suit.) It’s hard to imagine that Twitter isn’t planning a similar feature.

And yes, it is legal for these companies to do this— apart from Google’s opt-out option, your only real defense is
to stop recommending things via social media services.

Unless otherwise noted, this article is copyright © 2013 TidBITS Publishing,
Inc.. TidBITS is copyright © 2008 TidBITS Publishing Inc. Reuse governed by
this Creative Commons License: http://tidbits.com/terms/.

How to Prevent

from Monetizing Your Faceby Josh Centers
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Meeting Notes, October 12, 2013

Before the start of the meeting, Jim Trier passed around his phone to show a photo of Juliet, the
new addition to his family. During the sharing and question time, Bill Barr's comment about not having the
right adapter to connect a device as part of the program demo prompted Chod Lang to mention that
Monoprice.com is a good web source for purchasing adapters, with lower costs than Apple. Chod
mentioned that he can't get his apps onto his new phone. The problem started with his old phone and he
thought it was because the phone was broken. One suggestion was to try installing just one app and see if
that works (or what kind of message it prompts). Chod also mentioned that he was able to partition his
computer, which was running Snow Leopard, before he installed Mountain Lion. So he is still able to use
some of his older applications. This prompted a discussion of how updates affect availability of older
software applications.

Jim asked for suggestions from the photographers at the meeting for storing and editing photos. Lee Roth
said he stores all photos in Aperture and uses Elements for editing. Other tools mentioned for handling
photos were PhotoZoom Pro for resizing images, iView MediaPro for managing various digital files and
Authentec Perfectly Clear for automatically improving images.

David shared with us a video featuring cardiologist Dr. Eric Topol discussing and showing a number of
technologies and gadgets that can provide better care at lower cost, often using little more than a sensor
connected to a smartphone. If you would like to see the interview, here’s the link: www.youtube.com/watch?
v=0B-jUOOrtks.

We also watched a video on MacMost.com with information about some useful new features in iOS 7,
including an option for Dynamic Wallpaper (moving bubbles and choice of color), how to see time stamps
on messages and the fact that you can correct Siri’s pronunciation of names or words. This website also has
many, many video tutorials for users of Apple products. Bob Fasanello had updated his iPad with iOS 7, and
we got to see it projected on the screen while he shared some of the changes and new features with us.

Bill told us about Cyclemeter, a 5 star iPhone app he uses to track info when cycling, but which can also be
used for walking or running. It reads and records heart rate and other info, then the results can be emailed
or shared online.Cost is $4.99 at the app store.

by Doris Kiziah
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